Stat 328
Part-1
Statistical Analysis using Excel

There are many statistical analysis
methods can be achieved using Excel

1-1 Functions
Three different type of function can be
used in statistics; they are:

(a) Statistical Functions
(b) Mathematical Functions
(c) Logical Functions

These function can be obtained from
excel as:

Click the Formulas tab, then select the Insert Function command
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So, If we select the statistical to get a
list of possible statistical functions as

follows:

Count & Frequency

COUNT
COUNTA
COUNTBLANK
COUNTIF
COUNTIFS

FREQUENCY

Returns the number of numerical values in a supplied set of cells or values
Returns the number of non-blanks in a supplied set of cells or values
Returns the number of blank cells in a supplied range

Returns the number of cells (of a supplied range), that satisfy a given criteria

Returns the number of cells (of a supplied range), that satisfy a set of given
criteria (New in Excel 2007)

Returns an array showing the number of values from a supplied array, which
fall into specified ranges

Finding the Largest & Smallest Values

MAX
MAXA

LARGE

SMALL

Returns the largest value from a list of supplied numbers

Returns the largest value from a list of supplied values, counting text and
the logical value FALSE as the value 0 and counting the logical value TRUE
as the value 1

Returns the largest value from a subset of values in a list that are specified
according to one or more criteria. (New in Excel 2016)

Returns the smallest value from a list of supplied numbers

Returns the smallest value from a list of supplied values, counting text and
the logical value FALSE as the value 0 and counting the logical value TRUE
as the value 1

Returns the smallest value from a subset of values in a list that are
specified according to one or more criteria. (New in Excel 2016)

Returns the Kth LARGEST value from a list of supplied numbers, for a given
value K

Returns the Kth SMALLEST value from a list of supplied numbers, for a
given value K

Percentiles, Quartiles & Rank


http://www.excelfunctions.net/Excel-Count-Function.html
http://www.excelfunctions.net/Excel-Counta-Function.html
http://www.excelfunctions.net/Excel-Countblank-Function.html
http://www.excelfunctions.net/ExcelCountif.html
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http://www.excelfunctions.net/Excel-Frequency-Function.html
http://www.excelfunctions.net/MaxFunction.html
http://www.excelfunctions.net/Excel-Maxa-Function.html
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http://www.excelfunctions.net/SmallFunction.html

PERCENTILE

PERCENTILE.INC

PERCENTILE.EXC

QUARTILE

QUARTILE.INC

QUARTILE.EXC

RANK

RANK.EQ

RANK.AVG

PERCENTRANK

PERCENTRANK.INC

PERCENTRANK.EXC

Averages

AVERAGE
AVERAGEA

AVERAGEIF

AVERAGEIFS

Returns the K'th percentile of values in a supplied range, where K is in the
range O - 1 (inclusive) (Replaced by Percentile.Inc function in Excel 2010)

Returns the K'th percentile of values in a supplied range, where K is in the
range O - 1 (inclusive) (New in Excel 2010 - replaces the Percentile function)

Returns the K'th percentile of values in a supplied range, where K is in the
range O - 1 (exclusive) (New in Excel 2010)

Returns the specified quartile of a set of supplied numbers, based on
percentile value 0 - 1 (inclusive) (Replaced by Quartile.Inc function in Excel
2010)

Returns the specified quartile of a set of supplied numbers, based on
percentile value 0 - 1 (inclusive) (New in Excel 2010 - replaces the Quartile
function)

Returns the specified quartile of a set of supplied numbers, based on
percentile value 0 - 1 (exclusive) (New in Excel 2010)

Returns the statistical rank of a given value, within a supplied array of
values (Replaced by Rank.Eq function in Excel 2010)

Returns the Mode (the most frequently occurring value) of a list of
supplied numbers (if more than one value has same rank, the top rank of
that set is returned) (New in Excel 2010 - replaces the Rank function)

Returns the statistical rank of a given value, within a supplied array of
values (if more than one value has same rank, the average rank is
returned) (New in Excel 2010)

Returns the rank of a value in a data set, as a percentage (0 - 1
inclusive) (Replaced by Percentrank.Inc function in Excel 2010)

Returns the rank of a value in a data set, as a percentage (0 - 1
inclusive) (New in Excel 2010 - replaces the Percentrank function)

Returns the rank of a value in a data set, as a percentage (0 -1
exclusive) (New in Excel 2010)

Returns the Average of a list of supplied numbers

Returns the Average of a list of supplied numbers, counting text and the
logical value FALSE as the value 0 and counting the logical value TRUE as
the value 1

Calculates the Average of the cells in a supplied range, that satisfy a given
criteria (New in Excel 2007)

Calculates the Average of the cells in a supplied range, that satisfy multiple
criteria (New in Excel 2007)
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MEDIAN
MODE

MODE.SNGL

MODE.MULT

GEOMEAN
HARMEAN
TRIMMEAN

Deviation & Variance

AVEDEV

DEVSQ

STDEV

STDEV.S

STDEVA

STDEVP

STDEV.P

STDEVPA

VAR

Returns the Median (the middle value) of a list of supplied numbers

Returns the Mode (the most frequently occurring value) of a list of
supplied numbers (Replaced by Mode.Sngl function in Excel 2010)

Returns the Mode (the most frequently occurring value) of a list of
supplied numbers (New in Excel 2010 - replaces the Mode function)

Returns a vertical array of the most frequently occurring values in an array
or range of data (New in Excel 2010)

Returns the geometric mean of a set of supplied numbers
Returns the harmonic mean of a set of supplied numbers

Returns the mean of the interior of a supplied set of values

Returns the average of the absolute deviations of data points from their
mean

Returns the sum of the squares of the deviations of a set of data points
from their sample mean

Returns the standard deviation of a supplied set of values (which
represent a sample of a population) (Replaced by Stdev.S function in Excel
2010)

Returns the standard deviation of a supplied set of values (which
represent a sample of a population) (New in Excel 2010 - replaces the
Stdev function)

Returns the standard deviation of a supplied set of values (which
represent a sample of a population), counting text and the logical value
FALSE as the value 0 and counting the logical value TRUE as the value 1

Returns the standard deviation of a supplied set of values (which
represent an entire population) (Replaced by Stdev.P function in Excel
2010)

Returns the standard deviation of a supplied set of values (which
represent an entire population) (New in Excel 2010 - replaces the Stdevp
function)

Returns the standard deviation of a supplied set of values (which
represent an entire population), counting text and the logical value FALSE
as the value 0 and counting the logical value TRUE as the value 1

Returns the variance of a supplied set of values (which represent a sample
of a population) (Replaced by Var.S function in Excel 2010)


http://www.excelfunctions.net/Excel-Median-Function.html
http://www.excelfunctions.net/Excel-Mode-Function.html
http://www.excelfunctions.net/Excel-Mode-Sngl-Function.html
http://www.excelfunctions.net/Excel-Mode-Mult-Function.html
http://www.excelfunctions.net/Excel-Geomean-Function.html
http://www.excelfunctions.net/Excel-Harmean-Function.html
http://www.excelfunctions.net/Excel-Trimmean-Function.html
http://www.excelfunctions.net/Excel-Avedev-Function.html
http://www.excelfunctions.net/Excel-Devsq-Function.html
http://www.excelfunctions.net/Excel-Stdev-Function.html
http://www.excelfunctions.net/Excel-Stdev-S-Function.html
http://www.excelfunctions.net/Excel-Stdeva-Function.html
http://www.excelfunctions.net/Excel-Stdevp-Function.html
http://www.excelfunctions.net/Excel-Stdev-P-Function.html
http://www.excelfunctions.net/Excel-Stdevpa-Function.html
http://www.excelfunctions.net/Excel-Var-Function.html

VAR.S

VARA

VARP

VAR.P

VARPA

COVAR

COVARIANCE.P

COVARIANCE.S

Confidence Intervals

CONFIDENCE

CONFIDENCE.NORM

CONFIDENCE.T

Trend Line Functions

FORECAST

INTERCEPT

LINEST

Returns the variance of a supplied set of values (which represent a sample
of a population) (New in Excel 2010 - replaces the Var function)

Returns the variance of a supplied set of values (which represent a sample
of a population), counting text and the logical value FALSE as the value O
and counting the logical value TRUE as the value 1

Returns the variance of a supplied set of values (which represent an entire
population) (Replaced by Var.P function in Excel 2010)

Returns the variance of a supplied set of values (which represent an entire
population) (New in Excel 2010 - replaces the Varp function)

Returns the variance of a supplied set of values (which represent an entire
population), counting text and the logical value FALSE as the value 0 and
counting the logical value TRUE as the value 1

Returns population covariance (i.e. the average of the products of
deviations for each pair within two supplied data sets) (Replaced by
Covariance.P function in Excel 2010)

Returns population covariance (i.e. the average of the products of
deviations for each pair within two supplied data sets) (New in Excel 2010 -
replaces the Covar function)

Returns sample covariance (i.e. the average of the products of deviations
for each pair within two supplied data sets) (New in Excel 2010)

Returns the confidence interval for a population mean, using a normal
distribution (Replaced by Confidence.Norm function in Excel 2010)

Returns the confidence interval for a population mean, using a normal
distribution (New in Excel 2010 - replaces the Confidence function)

Returns the confidence interval for a population mean, using a Student's t
distribution (New in Excel 2010)

Predicts a future point on a linear trend line fitted to a supplied set of x-
and y- values

Calculates the best fit regression line, through a supplied series of x- and y-
values and returns the value at which this line intercepts the y-axis

Returns statistical information describing the trend of the line of best fit,
through a supplied series of x- and y- values
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http://www.excelfunctions.net/Excel-Covariance-S-Function.html
http://www.excelfunctions.net/Excel-Confidence-Function.html
http://www.excelfunctions.net/Excel-Confidence-Norm-Function.html
http://www.excelfunctions.net/Excel-Confidence-T-Function.html
http://www.excelfunctions.net/Excel-Forecast-Function.html
http://www.excelfunctions.net/Excel-Intercept-Function.html
http://www.excelfunctions.net/Excel-Linest-Function.html

SLOPE

TREND

GROWTH

LOGEST

STEYX

PERMUT

PERMUTATIONA

Returns the slope of the linear regression line through a supplied series of
x- and y- values

Calculates the trend line through a given set of y-values and returns
additional y-values for a supplied set of new x-values

Returns numbers in a exponential growth trend, based on a set of supplied
x- and y- values

Returns the parameters of an exponential trend for a supplied set of x-
and y- values

Returns the standard error of the predicted y-value for each x in the
regression line for a set of supplied x- and y- values

Returns the number of permutations
for a given number of objects

Returns the number of permutations
for a given number of objects (with
repetitions) that can be selected from
the total objects (New in Excel 2013)

Distribution & Tests of Probability

BETADIST

BETA.DIST

BETAINV

BETA.INV

BINOMDIST

BINOM.DIST

Returns the cumulative beta probability density
function (Replaced by Beta.Dist function in Excel 2010)

Returns the cumulative beta distribution function or the beta
probability density function (New in Excel 2010 - replaces the
Betadist function)

Returns the inverse of the cumulative beta probability density
function (Replaced by Beta.Inv function in Excel 2010)

Returns the inverse of the cumulative beta probability density
function (New in Excel 2010 - replaces the Betainv function)

Returns the individual term binomial distribution
probability (Replaced by Binom.Dist function in Excel 2010)

Returns the individual term binomial distribution
probability (New in Excel 2010 - replaces the Binomdist
function)
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BINOM.DIST.RANGE

NEGBINOMDIST

NEGBINOM.DIST

CRITBINOM

BINOM.INV

CHIDIST

CHISQ.DIST.RT

CHISQ.DIST

CHIINV

CHISQ.INV.RT

CHISQ.INV

CHITEST

CHISQ.TEST

CORREL
EXPONDIST

EXPON.DIST

FDIST

Returns the probability of a trial result using a binomial
distribution (New in Excel 2013)

Returns the negative binomial distribution (Replaced by
Negbinom.Dist function in Excel 2010)

Returns the negative binomial distribution (New in Excel 2010 -
replaces the Negbinomdist function)

Returns the smallest value for which the cumulative binomial
distribution is greater than or equal to a criterion
value (Replaced by Binom.Inv function in Excel 2010)

Returns the smallest value for which the cumulative binomial
distribution is greater than or equal to a criterion value (New in
Excel 2010 - replaces the Critbinom function)

Returns the right-tailed probability of the chi-squared
distribution (Replaced by Chisq.Dist.Rt function in Excel 2010)

Returns the right-tailed probability of the chi-squared
distribution (New in Excel 2010 - replaces the Chidist function)

Returns the chi-squared distribution (probability density or
cumulative distribution function) (New in Excel 2010)

Returns the inverse of the right-tailed probability of the chi-
squared distribution (Replaced by Chisq.Inv.Rt function in Excel
2010)

Returns the inverse of the right-tailed probability of the chi-
squared distribution (New in Excel 2010 - replaces the Chiinv
function)

Returns the inverse of the left-tailed probability of the chi-
squared distribution (New in Excel 2010)

Returns the chi-squared statistical test for
independence (Replaced by Chisq.Test function in Excel 2010)

Returns the chi-squared statistical test for independence (New
in Excel 2010 - replaces the Chitest function)

Returns the correlation coefficient between two sets of values

Returns the exponential distribution (Replaced by Expon.Dist
function in Excel 2010)

Returns the exponential distribution (New in Excel 2010 -
replaces the Expondist function)

Returns the right-tailed F probability distribution for two data
sets (Replaced by F.Dist.Rt function in Excel 2010)


http://www.excelfunctions.net/excel-binom-dist-range-function.html
http://www.excelfunctions.net/Excel-Negbinomdist-Function.html
http://www.excelfunctions.net/Excel-Negbinom-Dist-Function.html
http://www.excelfunctions.net/Excel-Critbinom-Function.html
http://www.excelfunctions.net/Excel-Binom-Inv-Function.html
http://www.excelfunctions.net/Excel-Chidist-Function.html
http://www.excelfunctions.net/Excel-Chisq-Dist-Rt-Function.html
http://www.excelfunctions.net/Excel-Chisq-Dist-Function.html
http://www.excelfunctions.net/Excel-Chiinv-Function.html
http://www.excelfunctions.net/Excel-Chisq-Inv-Rt-Function.html
http://www.excelfunctions.net/Excel-Chisq-Inv-Function.html
http://www.excelfunctions.net/Excel-Chitest-Function.html
http://www.excelfunctions.net/Excel-Chisq-Test-Function.html
http://www.excelfunctions.net/Excel-Correl-Function.html
http://www.excelfunctions.net/Excel-Expondist-Function.html
http://www.excelfunctions.net/Excel-Expon-Dist-Function.html
http://www.excelfunctions.net/Excel-Fdist-Function.html

F.DIST.RT

F.DIST

FINV

F.INV.RT

F.INV

FISHER
FISHERINV
FTEST

F.TEST

GAMMADIST

GAMMA.DIST

GAMMAINV

GAMMA.INV

GAMMA

GAMMALN

GAMMALN.PRECISE

GAUSS

HYPGEOMDIST

HYPGEOM.DIST

Returns the right-tailed F probability distribution for two data
sets (New in Excel 2010 - replaces the Fdist function)

Returns the F probability distribution (probability density or
cumulative distribution function) (New in Excel 2010)

Returns the inverse of the right-tailed F probability distribution
for two data sets (Replaced by F.Inv.Rt function in Excel 2010)

Returns the inverse of the right-tailed F probability distribution
for two data sets (New in Excel 2010 - replaces the Finv
function)

Returns the inverse of the Cumulative F distribution (New in
Excel 2010)

Returns the Fisher transformation
Returns the inverse of the Fisher transformation

Returns the result of an F-Test for 2 supplied data
sets (Replaced by F.Test function in Excel 2010)

Returns the result of an F-Test for 2 supplied data sets (New in
Excel 2010 - replaces the Ftest function)

Returns the gamma distribution (Replaced by Gamma.Dist
function in Excel 2010)

Returns the gamma distribution (New in Excel 2010 - replaces
the Gammadist function)

Returns the inverse gamma cumulative distribution (Replaced
by Gamma.Inv function in Excel 2010)

Returns the inverse gamma cumulative distribution (New in
Excel 2010 - replaces the Gammainv function)

Return the gamma function value for a supplied number (New
in Excel 2013)

Calculates the natural logarithm of the gamma function for a
supplied value

Returns the natural logarithm of the gamma function for a
supplied value (New in Excel 2010)

Calculates the probability that a member of a standard normal
population will fall between the mean and z standard
deviations from the mean (New in Excel 2013)

Returns the hypergeometric distribution (Replaced by
Hypgeom.Dist function in Excel 2010)

Returns the hypergeometric distribution (New in Excel 2010 -
replaces the Hypgeomdist function)
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KURT

LOGNORMDIST

LOGNORM.DIST

LOGINV

LOGNORM.INV

NORMDIST

NORM.DIST

NORMINV

NORM.INV

NORMSDIST

NORM.S.DIST

NORMSINV

NORM.S.INV

PEARSON
RSQ

PHI

POISSON

POISSON.DIST

PROB

Returns the kurtosis of a data set

Returns the cumulative log-normal distribution (Replaced by
Lognorm.Dist function in Excel 2010)

Returns the log-normal probability density function or the
cumulative log- normal distribution (New in Excel 2010 -
replaces the Lognormdist function)

Returns the inverse of the lognormal distribution (Replaced by
Lognorm.Inv function in Excel 2010)

Returns the inverse of the lognormal distribution (New in Excel
2010 - replaces the Loginv function)

Returns the normal cumulative distribution (Replaced by
Norm.Dist function in Excel 2010)

Returns the normal cumulative distribution (New in Excel 2010
- replaces the Normdist function)

Returns the inverse of the normal cumulative
distribution (Replaced by Norm.Inv function in Excel 2010)

Returns the inverse of the normal cumulative distribution (New
in Excel 2010 - replaces the Norminv function)

Returns the standard normal cumulative distribution (Replaced
by Norm.S.Dist function in Excel 2010)

Returns the standard normal cumulative distribution (New in
Excel 2010 - replaces the Normsdist function)

Returns the inverse of the standard normal cumulative
distribution (Replaced by Norm.S.Inv function in Excel 2010)

Returns the inverse of the standard normal cumulative
distribution (New in Excel 2010 - replaces the Normsinv
function)

Returns the Pearson product moment correlation coefficient

Returns the square of the Pearson product moment correlation
coefficient

Returns the value of the density function for a standard normal
distribution, for a supplied number (New in Excel 2013)

Returns the Poisson distribution (Replaced by Poisson.Dist
function in Excel 2010)

Returns the Poisson distribution (New in Excel 2010 - replaces
the Poisson function)

Returns the probablity that values in a supplied range are
within given limits
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SKEW
SKEW.P

STANDARDIZE
TDIST

T.DIST.2T

T.DIST.RT

T.DIST

TINV

T.INV.2T

T.INV

TTEST

T.TEST

WEIBULL

WEIBULL.DIST

ZTEST

Z.TEST

Returns the skewness of a distribution

Returns the skewness of a distribution based on a
population (New in Excel 2013)

Returns a normalized value

Returns the Student's T-distribution (Replaced by T.Dist.2t &
T.Dist.Rt functions in Excel 2010)

Returns the two-tailed Student's T-distribution (New in Excel
2010 - replaces the Tdist function)

Returns the right-tailed Student's T-distribution (New in Excel
2010 - replaces the Tdist function)

Returns the Student's T-distribution (probability density or
cumulative distribution function) (New in Excel 2010)

Returns the two-tailed inverse of the Student's T-
distribution (Replaced by T.Inv.2t function in Excel 2010)

Returns the two-tailed inverse of the Student's T-
distribution (New in Excel 2010 - replaces the Tinv function)

Returns the left-tailed inverse of the Student's T-
distribution (New in Excel 2010)

Returns the probability associated with a Student's T-
Test (Replaced by T.Test function in Excel 2010)

Returns the probability associated with a Student's T-Test (New
in Excel 2010 - replaces the Ttest function)

Returns the Weibull distribution (Replaced by Weibull.Dist
function in Excel 2010)

Returns the Weibull distribution (New in Excel 2010 - replaces
the Weibull function)

Returns the one-tailed probability value of a z-test (Replaced
by Z.Test function in Excel 2010)

Returns the one-tailed probability value of a z-test (New in
Excel 2010 - replaces the Ztest function)
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Similarly, if we select the Math& Trig
We get a list of possible Mathematical
functions as follows:

Basic Numeric Information

ABS
SIGN
GCD

LCM

Returns the absolute value (i.e. the modulus) of a supplied number
Returns the sign (+1, -1 or 0) of a supplied number
Returns the Greatest Common Divisor of two or more supplied numbers

Returns the Least Common Multiple of two or more supplied numbers

Basic Mathematical Operations

Ssum
PRODUCT
POWER
SQRT

QUOTIENT
MOD

AGGREGATE

SUBTOTAL

Returns the sum of a supplied list of numbers

Returns the product of a supplied list of numbers

Returns the result of a given number raised to a supplied power

Returns the positive square root of a given number

Returns the integer portion of a division between two supplied numbers
Returns the remainder from a division between two supplied numbers

Performs a specified calculation (e.g. the sum, product, average, etc.) for a list or
database, with the option to ignore hidden rows and error values (New in Excel
2010)

Performs a specified calculation (e.g. the sum, product, average, etc.) for a
supplied set of values

Rounding Functions

CEILING

CEILING.PRECISE

Rounds a number away from zero (i.e. rounds a positive number up and a
negative number down), to a multiple of significance

Rounds a number up, regardless of the sign of the number, to a multiple of
significance (New in Excel 2010)
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http://www.excelfunctions.net/Excel-Abs-Function.html
http://www.excelfunctions.net/Excel-Sign-Function.html
http://www.excelfunctions.net/Excel-Gcd-Function.html
http://www.excelfunctions.net/Excel-Lcm-Function.html
http://www.excelfunctions.net/Excel-Sum-Function.html
http://www.excelfunctions.net/Excel-Product-Function.html
http://www.excelfunctions.net/Excel-Power-Function.html
http://www.excelfunctions.net/Excel-Sqrt-Function.html
http://www.excelfunctions.net/Excel-Quotient-Function.html
http://www.excelfunctions.net/Excel-Mod-Function.html
http://www.excelfunctions.net/Excel-Aggregate-Function.html
http://www.excelfunctions.net/Excel-Subtotal-Function.html
http://www.excelfunctions.net/excel-rounding-functions.html
http://www.excelfunctions.net/Excel-Ceiling-Function.html
http://www.excelfunctions.net/Excel-Ceiling-Precise-Function.html

ISO.CEILING

CEILING.MATH

EVEN

FLOOR

FLOOR.PRECISE

FLOOR.MATH

MROUND

ODD

ROUND

ROUNDDOWN

ROUNDUP

TRUNC

Matrix Functions
MDETERM
MINVERSE
MMULT

MUNIT

Random Numbers

RAND

Rounds a number up, regardless of the sign of the number, to a multiple of
significance. (New in Excel 2010)

Rounds a number up to the nearest integer or to the nearest multiple of
significance (New in Excel 2013)

Rounds a number away from zero (i.e. rounds a positive number up and a
negative number down), to the next even number

Rounds a number towards zero, (i.e. rounds a positive number down and a
negative number up), to a multiple of significance

Rounds a number down, regardless of the sign of the number, to a multiple of
significance (New in Excel 2010)

Rounds a number down, to the nearest integer or to the nearest multiple of
significance (New in Excel 2013)

Rounds a number down to the next integer
Rounds a number up or down, to the nearest multiple of significance

Rounds a number away from zero (i.e. rounds a positive number up and a
negative number down), to the next odd number

Rounds a number up or down, to a given number of digits

Rounds a number towards zero, (i.e. rounds a positive number down and a
negative number up), to a given number of digits

Rounds a number away from zero (i.e. rounds a positive number up and a
negative number down), to a given number of digits

Truncates a number towards zero (i.e. rounds a positive number down and a
negative number up), to the next integer.

Returns the matrix determinant of a supplied array
Returns the matrix inverse of a supplied array
Returns the matrix product of two supplied arrays

Returns the unit matrix for a specified dimension (New in Excel 2013)

Returns a random number between 0 and 1
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http://www.excelfunctions.net/Excel-Iso-Ceiling-Function.html
http://www.excelfunctions.net/excel-ceiling-math-function.html
http://www.excelfunctions.net/Excel-Even-Function.html
http://www.excelfunctions.net/Floor-Function.html
http://www.excelfunctions.net/Excel-Floor-Precise-Function.html
http://www.excelfunctions.net/excel-floor-math-function.html
http://www.excelfunctions.net/Int-Function.html
http://www.excelfunctions.net/Excel-Mround-Function.html
http://www.excelfunctions.net/Excel-Odd-Function.html
http://www.excelfunctions.net/Round-Function.html
http://www.excelfunctions.net/Excel-Rounddown-Function.html
http://www.excelfunctions.net/Excel-Roundup-Function.html
http://www.excelfunctions.net/Excel-Trunc-Function.html
http://www.excelfunctions.net/Excel-Mdeterm-Function.html
http://www.excelfunctions.net/Excel-Minverse-Function.html
http://www.excelfunctions.net/Excel-Mmult-Function.html
http://www.excelfunctions.net/excel-munit-function.html
http://www.excelfunctions.net/Excel-Rand-Function.html

RANDBETWEEN Returns a random number between two given integers

Conditional Sums

SUMIE Adds the cells in a supplied range, that satisfy a given criteria
SUMIES Adds the cells in a supplied range, that satisfy multiple criteria (New in Excel
2007)

Advanced Mathematical Operations

SUMPRODUCT Returns the sum of the products of corresponding values in two or more supplied

arrays

SUMS Returns the sum of the squares of a supplied list of numbers

SUMX2MY?2 Returns the sum of the difference of squares of corresponding values in two
supplied arrays

SUMX2PY?2 Returns the sum of the sum of squares of corresponding values in two supplied
arrays

SUMXMY?2 Returns the sum of squares of differences of corresponding values in two

supplied arrays

SERIESSUM Returns the sum of a power series

Trigonometry Functions

Pl Returns the constant value of pi

SORTPI Returns the square root of a supplied number multiplied by pi
DEGREES Converts Radians to Degrees

RADIANS Converts Degrees to Radians

COS Returns the Cosine of a given angle

ACOS Returns the Arccosine of a number

COSH Returns the hyperbolic cosine of a number

ACOSH Returns the inverse hyperbolic cosine of a number

SEC Returns the secant of an angle (New in Excel 2013)

SECH Returns the hyperbolic secant of an angle (New in Excel 2013)
SIN Returns the Sine of a given angle

ASIN Returns the Arcsine of a number
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http://www.excelfunctions.net/Excel-Randbetween-Function.html
http://www.excelfunctions.net/ExcelSumif.html
http://www.excelfunctions.net/Excel-Sumifs-Function.html
http://www.excelfunctions.net/Excel-Sumproduct-Function.html
http://www.excelfunctions.net/Excel-Sumsq-Function.html
http://www.excelfunctions.net/Excel-Sumx2my2-Function.html
http://www.excelfunctions.net/Excel-Sumx2py2-Function.html
http://www.excelfunctions.net/Excel-Sumxmy2-Function.html
http://www.excelfunctions.net/Excel-Seriessum-Function.html
http://www.excelfunctions.net/Excel-Pi-Function.html
http://www.excelfunctions.net/Excel-Sqrtpi-Function.html
http://www.excelfunctions.net/Excel-Degrees-Function.html
http://www.excelfunctions.net/Excel-Radians-Function.html
http://www.excelfunctions.net/Excel-Cos-Function.html
http://www.excelfunctions.net/Excel-Acos-Function.html
http://www.excelfunctions.net/Excel-Cosh-Function.html
http://www.excelfunctions.net/Excel-Acosh-Function.html
http://www.excelfunctions.net/excel-sec-function.html
http://www.excelfunctions.net/excel-sech-function.html
http://www.excelfunctions.net/Excel-Sin-Function.html
http://www.excelfunctions.net/Excel-Asin-Function.html

coT
COTH
ACOT
ACOTH

Returns the Hyperbolic Sine of a number

Returns the Inverse Hyperbolic Sine of a number

Returns the cosecant of an angle (New in Excel 2013)

Returns the hyperbolic cosecant of an angle (New in Excel 2013)
Returns the Tangent of a given angle

Returns the Arctangent of a given number

Returns the Arctangent of a given pair of x and y coordinates
Returns the Hyperbolic Tangent of a given number

Returns the Inverse Hyperbolic Tangent of a given number
Returns the cotangent of an angle (New in Excel 2013)

Returns the hyperbolic cotangent of an angle (New in Excel 2013)
Returns the arccotangent of a number (New in Excel 2013)
Returns the hyperbolic arccotangent of a number (New in Excel 2013)

Exponents & Logarithms

EXP
LN

LOG

LOG10

Factorials
FACT

FACTDOUBLE
MULTINOMIAL

Miscellaneous

BASE

DECIMAL

COMBIN

COMBINA

ARABIC

Returns e raised to a given power

Returns the natural logarithm of a given number

Returns the logarithm of a given number, to a specified base
Returns the base 10 logarithm of a given number

Returns the Factorial of a given number
Returns the Double Factorial of a given number
Returns the Multinomial of a given set of numbers

Converts a number into a text representation, with the supplied base (New in
Excel 2013)

Converts a text representation of a number in a specified base into a decimal
number (New in Excel 2013)

Returns the number of combinations (without repititions) for a given number of
objects

Returns the number of combinations (with repetitions) for a given number of
items (New in Excel 2013)

Converts a Roman numeral to an Arabic numeral (New in Excel 2013)
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http://www.excelfunctions.net/Excel-Sinh-Function.html
http://www.excelfunctions.net/Excel-Asinh-Function.html
http://www.excelfunctions.net/excel-csc-function.html
http://www.excelfunctions.net/excel-csch-function.html
http://www.excelfunctions.net/Excel-Tan-Function.html
http://www.excelfunctions.net/Excel-Atan-Function.html
http://www.excelfunctions.net/Excel-Atan2-Function.html
http://www.excelfunctions.net/Excel-Tanh-Function.html
http://www.excelfunctions.net/Excel-Atanh-Function.html
http://www.excelfunctions.net/excel-cot-function.html
http://www.excelfunctions.net/excel-coth-function.html
http://www.excelfunctions.net/excel-acot-function.html
http://www.excelfunctions.net/excel-acoth-function.html
http://www.excelfunctions.net/Excel-Exp-Function.html
http://www.excelfunctions.net/Excel-Ln-Function.html
http://www.excelfunctions.net/Excel-Log-Function.html
http://www.excelfunctions.net/Excel-Log10-Function.html
http://www.excelfunctions.net/Excel-Fact-Function.html
http://www.excelfunctions.net/Excel-Factdouble-Function.html
http://www.excelfunctions.net/Excel-Multinomial-Function.html
http://www.excelfunctions.net/excel-base-function.html
http://www.excelfunctions.net/excel-decimal-function.html
http://www.excelfunctions.net/Excel-Combin-Function.html
http://www.excelfunctions.net/excel-combina-function.html
http://www.excelfunctions.net/excel-arabic-function.html

ROMAN

Returns a text string depicting the roman numeral for a given number

Also, if we select the Logical, we get a list
of possible logical functions as follows:

Function

AND
function

FALSE
function

IF function

IFERROR
function

IFNA
function

[FS function

NOT
function

OR function

SWITCH
function

TRUE
function

XOR
function

Description

Returns TRUE if all of its arguments are TRUE

Returns the logical value FALSE

Specifies a logical test to perform

Returns a value you specify if a formula evaluates to an error; otherwise,
returns the result of the formula

Returns the value you specify if the expression resolves to #N/A, otherwise
returns the result of the expression

Checks whether one or more conditions are met and returns a value that
corresponds to the first TRUE condition.

Reverses the logic of its argument

Returns TRUE if any argument is TRUE

Evaluates an expression against a list of values and returns the result
corresponding to the first matching value. If there is no match, an optional
default value may be returned.

Returns the logical value TRUE

Returns a logical exclusive OR of all arguments
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http://www.excelfunctions.net/Excel-Roman-Function.html
https://support.office.com/en-us/article/AND-function-5f19b2e8-e1df-4408-897a-ce285a19e9d9
https://support.office.com/en-us/article/AND-function-5f19b2e8-e1df-4408-897a-ce285a19e9d9
https://support.office.com/en-us/article/FALSE-function-2d58dfa5-9c03-4259-bf8f-f0ae14346904
https://support.office.com/en-us/article/FALSE-function-2d58dfa5-9c03-4259-bf8f-f0ae14346904
https://support.office.com/en-us/article/IF-function-69aed7c9-4e8a-4755-a9bc-aa8bbff73be2
https://support.office.com/en-us/article/IFERROR-function-c526fd07-caeb-47b8-8bb6-63f3e417f611
https://support.office.com/en-us/article/IFERROR-function-c526fd07-caeb-47b8-8bb6-63f3e417f611
https://support.office.com/en-us/article/IFNA-function-6626c961-a569-42fc-a49d-79b4951fd461
https://support.office.com/en-us/article/IFNA-function-6626c961-a569-42fc-a49d-79b4951fd461
https://support.office.com/en-us/article/IFS-function-36329a26-37b2-467c-972b-4a39bd951d45
https://support.office.com/en-us/article/NOT-function-9cfc6011-a054-40c7-a140-cd4ba2d87d77
https://support.office.com/en-us/article/NOT-function-9cfc6011-a054-40c7-a140-cd4ba2d87d77
https://support.office.com/en-us/article/OR-function-7d17ad14-8700-4281-b308-00b131e22af0
https://support.office.com/en-us/article/SWITCH-function-47ab33c0-28ce-4530-8a45-d532ec4aa25e
https://support.office.com/en-us/article/SWITCH-function-47ab33c0-28ce-4530-8a45-d532ec4aa25e
https://support.office.com/en-us/article/TRUE-function-7652c6e3-8987-48d0-97cd-ef223246b3fb
https://support.office.com/en-us/article/TRUE-function-7652c6e3-8987-48d0-97cd-ef223246b3fb
https://support.office.com/en-us/article/XOR-function-1548d4c2-5e47-4f77-9a92-0533bba14f37
https://support.office.com/en-us/article/XOR-function-1548d4c2-5e47-4f77-9a92-0533bba14f37

Examples

1- Math & Tri functions

No | Function syntax Description Examples
1 ABS ABS(number) Valuate the absolute value Abs(6) = 6
of a number Abs(-5) =5
2 Combin Combin(n;x) Calculate the binomial Combin(5;3)=10
- - n
coefficients
X
3
4
5
6

2-Statistical functions

No | Function syntax Description Examples
1 Average average(al; a2; ... | Calculate the mean of al, AVERAGE(1,8,9,2)=5
an) a2,....an

2 normdist

Normdist(x; mean;
standard deviation;
cumulative)

Calculate the cumulative
probability function on
normal distribution with
given mean and standard
derivation)

Normdist( 1.96; 0; 1; True) = 0.9750

3 Norminv

3-Logical statements

No | Function syntax Description Examples
1 If If( logical test; If statement; do statement 1 if | Let x be a column of values 1, 2,
statmentl if true; true, do statement 2 if false 3. write the following statement in
statement 2 if false) the first cell of the columny
if(x2<=1; 1; 2). The output of the
column y will be 1,2,3.
2
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Some other examples on the statistical functions
Examples

1- Calculate the mean, median, variance, standard deviation and mode(s) for
the following data

2,3,2,2,0,2,3,6,3,2,2,4,3,1,3,3,3,2,1,5

To achieve this in excel put the data in a column (A1:A20) or raw

and use the following commands

=AVERAGE(A1:A20)

=MEDIAN(A1:A20)

=STDEV.S(A1:A20)

=STDEV.P(A1:A20)

=VAR.P(A1:A20)

=VAR.S(A1:A20)

2- Frequency Table (Frequency-example)

3- Probability distributions

If X ~N(2,7) , then Calculate



P(X <15), f(@3), P(X <k)=0.25, k?

Some other examples on the mathematical functions

Example
Calculate exp(-1.5), Log(25) and In(25)

Example on the logical functions

Use if statement to print the status of the student (Pass > 60, fail <60)

In creation exam using the following marks

Marks
70
85
83
25
80
98
80
72
42

If(A1<60’7’F7””P7’)



1 | Mochaldren

e

X2

Some mathematical, statistical and logical functions in excel

Some Examples on the Mathematical Function

e-15 =EXP(-1.5) 0.22313016
log(25) =LOG(25) 1.397940009
In(25) =LN(25) 3.218875825
(10) =COMBIN(10,2)
2 45
V25 =SQRT(25) 5
|—10] =ABS(-10) 10
32 =POWER(3,2)
=3"2 9
Some Examples on the Statistical Function
Example

Suppose we are interested in the number of children that a Saudi woman has and
we take a sample of 20 women and obtain the following data on the number of

children

2,3,2,2,0,2,3,6,3,2,2,43,1,3,3,3,2,1,5

A312

- Calculate the mean, median, variance, standard deviation, total,
maximum, minimum and mode(s)

To achieve this in excel put the data in a column (A2:A21) or raw and use
the following commands

Total =SUM(A2:A21) 52
Mean =AVERAGE(A2:A21) 2.6
Median =MEDIAN(A2:A21) 2.5
Max =MAX(A2:A21) 6
Min =MIN (A2:A21) 0
Standard =STDEV(A2:A21) New in Excel 2010 | 1.353358

‘\Lﬂl'I'.-l.uwml-whluluwﬂ.mhﬁh.l|u\.'\.||u
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deviation for =STDEV.S(A2:A21)

sample

Standard = STDEV P(A2:A21) | New inExcel 2010

deviation for =STDEV.P(A2:A21)

population 1.319091
Variance for | =VAR(A2:A21) New in Excel 2010

sample =VAR.S(A2:A21) | 1.831579
Variance for | =VARP (A2:A21) New in Excel 2010

population =VAR.S(A2:A21) 1.74

- Frequency Table

N.children Frequency
0 =COUNTIF(A2:A21,707) 1
1 =COUNTIF(A2:A21,”17) 2
2 =COUNTIF(A2:A21,72”) 7
3 =COUNTIF(A2:A21,”3”) 7
4 =COUNTIF(A2:A21,74”) 1
5 =COUNTIF(A2:A21,”5”) 1
6 =COUNTIF(A2:A21,76”) 1
- Probability distributions
If X~N(2,7), then Calculate
P(X < 1.5) =NORMDIST(1.5,2,7, TRUE) | 0.471528
P(X <k)=0.25k? |=NORMINV(0.25,2,7) -2.72143

Example on the Logical Functions
Use if statement to print the status of the student (Pass = 60, Fail < 60). In
creation exam using the following marks

A

1 Marks | Function Grade
2 70 =IF(A2<60,”Fail”,”Pass”) | Pass
3 85 =IF(A3<60,”Fail”,”Pass™) | Pass
4 83 =IF(A4<60,”Fail”,”Pass”) | Pass
5 25 =IF(A5<60,”Fail”,”Pass”) | Fail

6 80 =IF(A6<60,”Fail”,”Pass”) | Pass
7 98 =IF(A7<60,”Fail”,”Pass”) | Pass




8 80 =IF(A8<60,”Fail”,”Pass”) | Pass
9 72 =IF(A9<60,”Fail”,”Pass”) | Pass
10 42 =IF(A10<60,”Fail”,”Pass”) | Fail
11 32 =IF(A11<60,”Fail”,”Pass”) | Fail




Descriptive statistics using excel

- Data Analysis

The Analysis ToolPak is an Excel add-in program that provides data analysis tools
for financial, statistical and engineering data analysis.

To load the Analysis ToolPak add-in, execute the following steps.

1. Click on Excel Options.

X I
.i. Home |

[ save
Save As
Lj Open

O Close

E s

Recent

Mew

Print

Save & Send

Help

] Options

k4 Exit

2. Under Add-ins, select Analysis ToolPak and click on the Go button.



Excel Options
General E . . . .
View and manage Microsoft Office Add-ins.
Formulas
Proofing Add-ins
Save Mame = Location Type -
Language Active Application Add-ins
Mo Active Appilication Add-ins
Advanced
Inactive Application Add-ins
Customize Ribbon Analysis ToolPak G LYS32XLL Excel Add-in
Analysis ToolPak - VBA ChGAEMXLAM Excel Add-in
Quick Access Toolbar Custom XML Data G FRHDL.DLL  Document Inspector
Euro Currency Tools i OLXLAM Excel Add-in
Add-Ins Financial Symbal [KML) Ch G MOFLDLL  Action
Headers and Footers W FRHD.DLL  Document Inspectar —
Trust Center Hidden Rows and Calumns C...FRHD.DLL Document Inspectar
Hidden Warksheets ChWGFRHDL.DLL  Document Inspector
Invisible Content ChGFRHD.DLL  Document Inspector
Microsoft Actions Pane 3 XML Expansion Pack
Solver Add-in G VERXLAM Excel Add-in -
Add-in: Analysis ToolPak
Publisher: Microsoft Corporation
Compatibility: Mo compatibility information available
Location: ChProgram Files pBol\Microsoft Office\Officeld \Library,
Analysis\ANALY32 XLL
Description: Provides data analysis tools for statistical and
engineering analysis
Manage: | Excel Add-ins EI
| ok || cance

3. Check Analysis ToolPak and click on OK.



Add-Ins

Add-Ins available:
iz ToolPak

[ salver Add-in

| Analysis ToolPak - VBA
[ Bure currency Tools

Cancel

Browse...

i
]

Automation...

Analysis ToolPak

Provides data analysis tools for statistical and
engineering analysis

4. On the Data tab, you can now click on Data Analysis.

Data Review View Developer
§ Clear E = =~ o Group -
3 Reapply -

_{?
Text to Remove -

¥ Advanced | Columns Duplicates =2~ | i Subtotal

o @ Ungroup = =

BT Data Tools Cutline

& @ o = =
ﬂ% Data Analysis

o

] Analysis

The following dialog box below appears.

Data Analysis
Analysis Tools

Correlation

Covariance

Descriptive Statistics
Exponential Smoothing

F-Test Two-Sample for Variances

Fourier Analisjs

Moving Average
Random Mumber Generation
Rank and Percentile

m




Examples on Data analysis

Descriptive Statistics
You can use the Analysis Toolpak add-in to generate descriptive statistics. For

example, you may have the scores of 14 participants for a test.

M26
A B

1 5Scores

2 82

3 93

4 91

3 69

6 96

7 6l

8 88

9 58
10 329
11 100
12 93
13 71
14 78
15 98
16

17

To generate descriptive statistics for these scores, execute the following steps.
1. On the Data tab, click Data Analysis.

Data Review View Developer [ ﬁ o EE EX
=] = I T = : - = |EL ;
3 e = & Group = |[fg Data Analysis
=== - T “# Ungroup = =%

= Textto  Remove : =
¥ Advanced | Columns Duplicates =2~ | i Subtotal

BI [Data Tools Cutline Analysis

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak
add-in.

2. Select Descriptive Statistics and click OK.
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Data Analysis
Analysis Tools

Anova: Single Factor

Anova: Two-Factor With Replication
Anova: Two-Factor Without Replication
Correlation

Covariance

Exponential Smoothing

F-Test Two-Sample for Variances
Fourier Analysis

Histogram

| »

m

Descriptive Statistics |

-7l
Ok k

Cancel

Help

4. Select cell C1 as the Output Range.

. Select the range A2:A15 as the Input Range.

. Make sure Summary statistics is checked.

Descriptive Statistics
Input
Input Range: SAS52:5A515
Grouped By: (@ Columns
(7) Rows
[7] Labelz in first row

QOutput options

i@ Qutput Range: sl ez
() Mew Worksheet Ply:

) Mew Workbook

[] confidence Level for Mean: 95 gL
[7] th Largest: 1
[] Kth Smallest: 1

Bl xS

OK

Cancel

Help

6. Click OK.
Result:

(S, ]




128 - |

A B C D
1 Scores Columni
2 82
3 93 Mean 81.21428571
4 91 Standard Error 4.045318243
5 69 Median 85
b 96 Mode 93
7 61 Standard Deviation  15.13619489
8 88 Sample Variance 229.1043956
9 S8 Kurtosis -1.426053506
10 39 Skewness -0.402108004
11 100 Range 42
12 93 Minimum 58
13 71 Maximum 100
14 78 Sum 1137
15 98 Count 14
16
17



Statistical tests using excel
1- Analysis of variance (ANOVA)
- One Way ANOVA

a = 0.05.
Hypotheses testing:

Ho:py = pp = -+ = pig
H,: at least one of the means is different.
Test statistic:
p o MSA
MSE

Critical region:

Reject Hy if F > Fi_y (v, v,)
Or
p —value < a

Decision:

This example teaches you how to perform a single factor ANOVA (analysis of
variance) in Excel. A single factor or one-way ANOVA is used to test the null
hypothesis that the means of several populations are all equal.

Below you can find the salaries of people who have a degree in economics,

medicine or history.




HI1E ~ ft|

A B C D

1 economics medicine history

2 42 69 35
2 53 54 40
4 49 58 53
3 33 64 42
B 43 64 50
7 44 55 a9
a8 45 56 55
9 52 33
10 54 40
11

12

To perform a single factor ANOVA, execute the following steps.
1. On the Data tab, click Data Analysis.

Data Review View Developer [ e = B &3

r. -~

i =i~ @ Group -~ *= [ Data Analysis

& Reapply B ¢ Ungroup = ==

T Textto  Remove . :
J? Advanced | Columns Duplicates =P~ £ subtotal

Br Data Tools Cutline = Analysis

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak
add-in.
2. Select Anova: Single Factor and click OK.

Data Analysis [~ S|
Analysis Tools
0K
- -k

Anova: Two-Factor With Replication
Anova: Two-Factor Without Replication
Correlation

Covariance

Descriptive Statistics

Exponential Smoothing

F-Test Two-Sample for Variances
Fourier Analysis

Histogram

-

-

3. Click in the Input Range box and select the range A2:C10.
4. Click in the Output Range box and select cell E1.



Anova: Single Factor
Input
Input Range:

Grouped By:

[] Labels in first row
Alpha: |0.05

QOutput options

@ Output Range:

1 New Worksheet Bly:
) Mew Workboak

$AS2:5C510 _

@ Columns
) Rows

sES|

-7l

Cancel

Help

Efa

5. Click OK.
Result:

E
Anova: Single Factor

SUMMARY

Groups

Count

Sum Average Variance

Column 1
Column 2
Column 3

435 48.33333 23.5

420 60 32.33333
393 43.06667 50.5

ANOWVA

Source of Variation

55

df S F P-value F crit

Between Groups
Within Groups

Total

1085.84
786

1871.84

2 542,92 15.19623 7.16E-05 3.443357
22 35.72727

24




a = 0.05.

Hypotheses testing:

Ho:py = pa = i3
H,: at least one of the means is different.

Test statistic:

F = M34 _ 15.19623
- MSE T

Critical region:

Fi-av,v, = F crit = 3.443357

p — value = 0.00007163

Reject Hy if F > 3.443
Or
p — value < 0.05

Decision:
Therefore, we reject the null hypothesis. The means of the three populations are
not all equal. At least one of the means is different. However, the ANOVA does

not tell you where the difference lies. You need a t-Test to test each pair of means.

10



- Two-Factor Analysis of Variance

a = 0.05.

The three hypotheses to be tested are as follows:
Hypotheses testing:

1.H0:a1=a2="'=aa=0

H;: At least one of the a; is not equal to zero.

2.Hy: =B, =--=B,=0
H;: Atleast one of the §; is not equal to zero.
3. Ho: (@B)11 = (@Bl == (aB)ap =0

H;: Atleast one of the (af);; is not equal to zero.

Critical region:

p —value < a

Decision:

- ANOVA two ways with Replication

In the following example, the cost of three swimming programs in two regions in
the East and the West

SQ RQ TQ
East 19 8 21
18 10 31
25 10 26
20 18 28
17 7 14
21 16 24
West 15 23 31
28 32 31
17 26 26
14 16 20
17 27 14
13 18 9

11




1. On the Data tab, click Data Analysis.

Data Review View Developer [ a = BE E3
x Clear E = B~ 9 Group T #Z dng Data Analysis
{; Reapply Fim ¥ Ungroup = ==

T Textto  Remowve :
Au? Advanced | Columns Duplicates =2 £l subtotal

BF Data Tools Qutline a Analysis

2. Select Anova: Two-Factor With Replication and click OK.

A B C D E F [<] H | J K
1 sQ |rQ [TQ
2 |East 19 8 21
3 18 10 31
4 25 10 26
5 20 18 28 )
6 17 |7 14 Datz Analysis =
Andyeic Taols
! 21 16 24 Anova: Sngle Factor - ILI
g [West |15 23 31 Anoya: Teo-Fachor With Reclcation Cancel
Anova: Twa-Factor Wthout Replcation ]
3 26 32 31 Carrelaton 5
Cavariznoe gep
10 17 26 26 Di=sripbive Stalistics
Ewponential Smoothing
11 14 e 20 F-Tegt Twa-Sample for Varianoes
i
12 17 |27 |14 Hstogram .
13 13 18 9 |

3. Click in the Input Range box and select the range A1:D13.
4. Click in the Output Range box and select cell E2.

Anova: Two-Factor With Replication
Input —_—
Irout Rarge: '.E] ke

Ceno=l
Bowa per sample: g
aloha: 1.05 .L
Output options
i) Duput Range: T
1@ Hew Warksheet Ply: El
) M Warkbook
5. Click OK.
Result:

12




Anova: Two-Factor With Replication

SUMMARY sQ RQ TQ Total
Easi
Count 6 6 G 18
Sum 120 69 144 333
Average 20 1.5 24 18.5
Variance 8 19.9 356 4744118
Wesi
Count 6 6 G 18
Sum 102 142 131 375
Average 17 23.66667 2183333 20.83333 I _I
Variance 22 3546667 8296667 4967647
Tofal
Count 12 12 12
Sum 222 21 275
Average 18.5 17.58333 22 91667
Variance 16.09091 B5.A3788 5517424
AMNOVA
Source of Vanation 55 ar ME F P-yaive F ot
Sample 49 1 49 1.441648| 0.239268) 4 170877
Columns 195 1667 2 9758333 2871036 0.072297| 3.31583
Interaction 436 1667 2 218.0833 6416313 0.004788| 3.31583
Within 1019.667 30 33.98889
Total 1700 35
a = 0.05.

1) Hypotheses testing:

Hy: aggst = Qyest = 0

H,: at least one of the means is different.

Test statistic:

F =1.4416

Critical region:

Fl—a,(vl,vz) = F crit = 4.1708

13



p — value = 0.2392
Reject Hy if F > 4.1708 Or p — value < 0.05

Decision:
Therefore, we not reject the null hypothesis. There are no difference in the means

of the cost between the two regions in the east and the west.

2) Hypotheses testing:

Hy: Bsq = Pro = Bro =0
H,: at least one of the means is different.

Test statistic:

F =2.871

Critical region:

Fl—a,(vl,vz) = F crit = 3.3158
p — value = 0.0722
Reject Hy if F > 3.3158 Or p — value < 0.05

Decision:
Therefore, we not reject the null hypothesis. There was no significant difference

between the mean cost of the three programs.

3) Hypotheses testing:

Hy: aﬁEast,SQ = a:BEast,RQ = aﬁEast,TQ = a.BWest,SQ = aIBWeSI:,RQ = a:BWest,TQ =0

H,: at least one of the means is different.

14



Test statistic:

F =6.4163

Critical region:

Fl—a,(vl,vz) = F crit = 3.3158
p — value = 0.0047
Reject Hy if F > 3.3158 Or p — value < 0.05

Decision:
Therefore, we reject the null hypothesis. There is interaction between the two

factors (region, type of program).

15



- ANOVA two ways without Replication

In the following example, the price of three swimming programs in six areas

SQ RQ TQ
1 19 8 21
2 18 10 31
3 25 10 26
4 20 18 28
5 17 7 14
6 21 16 24

a = 0.05

The two hypotheses to be tested are as follows:
Hypotheses testing:

1. Hyap=a,==a,=0

H;: At least one of the a; is not equal to zero.
2.Ho:py=P2==pp=0

H;: At least one of the f; is not equal to zero.

Critical region:

p —value < a

Decision:

1. On the Data tab, click Data Analysis.

Data Review View Developer o @. = EE ER
= D =l - - = 1 .
-_l:_ d_.g ﬂ = Group =  |Erg Data Analysis
== = =

T & Ungroup -
7 Textto  Remove : =
X7 pdvanced | cColumns Duplicates 52~ | (4 Subtotal

BT Data Tools Cutline Analysis

2. Select Anova: Two-Factor With Replication and click OK.
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Deta Analysis -2
Aralyss Tooks E

Aroia: Snple Factor
Anava: Two-Factor Yith Replcation Cancel
Arava: Two-Factor Without Reclicabon

Comelation |:
Coverisnce bep
Diescriptive Sabstics

Exponential Smaathing

F-Test Two-Sample for Yarianoze

Fauriar Aralyas

Hetagram i

| *

[l

3. Click in the Input Range box and select the range B2:D7.
4. Click in the Output Range box and select cell E3.

Anowa: Two-Factor Without Replication |t ]
Input
Input Rangs: SEE 2 E0ET E
| Labelks | Carcel |

Apha:  |0.05 Help
Cutput opticns
1 Cutput Range: =_|!§
@ Maw Worksheet Ply: E3d
7 Mew Workboak

5. Click OK.

Result:
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Anova: Two-Factor Without Replication | I

sURIMARY  Count Sum Average  Vofionoe

Row 1 3 43 1a 49

Riowr 2 3 5% 1900667 112.3333

Riowy 3 3 61 2033333 30.33332

Ry 4 3 65 12 28

Riowy 5 3 33 1266667 26.33333

Row 6 3 61 2033333 16.33333

Column 1 B 120 20 8

Column 2 & 69 11.5 19.9

Column 2 i3 144 24 5.6

ANOWA

weof Voric 55 of M5 F F-value Forit
Ronws 1818332 3 32636667 263059 0.0836613 3.3238315
Columns 489 2 244.5 18.02211 0.000433 41028321
Emror 135 6667 10 13 56667

Total B0.5 17

a = 0.05.

1) Hypotheses testing:

Ho:a1=a2="'=a6=0
H,: at least one of the means is different.

Test statistic:

F =2.6805

Critical region:

Fl—a,(vl,vz) = F crit = 3.3258

p — value = 0.0866

18



Reject Hy if F > 3.3258 Or p —value < 0.05

Decision:
Therefore, we not reject the null hypothesis. There are no difference in the means

of the cost between the six areas.

2) Hypotheses testing:

HO:,BSQ = .BRQ = .BTQ =0
H,: at least one of the means is different.

Test statistic:

F =18.022

Critical region:

Fl—oc,(vl,vz) = F crit = 4.1028
p — value = 0.0004
Reject Hy if F > 4.1028 Or p — value < 0.05

Decision:
Therefore, we reject the null hypothesis. There is a significant difference between

the mean prices of the three programs.
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3- F-Test

This example teaches you how to perform an F-Test in Excel. The F-Test is used to
test the null hypothesis that the variances of two populations are equal.

Below you can find the study hours of 6 female students and 5 male students.

HO: 612 =622
Hl: o012 #0622
H15 - I
A B C

1 Female Male
2 26 23
3 25 30
4 43 13
5 34 25
o 18 28
7 52
&
9

To perform an F-Test, execute the following steps.
1. On the Data tab, click Data Analysis.

Cata Review View Developer & @ = eH 3
—= | =] - i - §:|_ )
. el = 2 Group iq Data Analysis

3 S=2 = Fin @ Ungroup =
7 Textto  Remove ER
X pdvanced | Columns Duplicates =2~ | B Subtotal

EF Drata Tools Outline Analysis

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak
add-in.

2. Select F-Test Two-Sample for Variances and click OK.


http://www.excel-easy.com/data-analysis/analysis-toolpak.html
http://www.excel-easy.com/data-analysis/analysis-toolpak.html

Data Analysis [~ B |3
Analysis Tools

-DK

R

Anova: Single Factor -

Anova: Two-Factor With Replication “' ‘

Anova: Two-Factor Without Replication

Correlation
Covariance i
Desciptive Statistics

Exponential Smoothing
Fourier Analysis
Histogram o

3. Click in the Variable 1 Range box and select the range A2:A7.
4. Click in the Variable 2 Range box and select the range B2:B6.
5. Click in the Output Range box and select cell E1.

F-Test Two-Sample for Variances @
Input
Variable 1 Range: SAS2:SAST
Variable 2 Range: ¢peD: ERES
[ Labels

Alpha: |0.05

QOutput options
@ Qutput Range: $E%1|
(71 Mew Worksheet Ply:

;{i

(71 Mew Workbook

6. Click OK.
Result:

E F G
F-Test Two-Sample for Variances

Variable 1 Variable 2

Mean 33 24.8
Variance 160 21.7
Observations 6 3
df 3 4
F 7.3732T1889
P(F==f} one-tail 0.037888376
F Critical one-tail 6.256056502




Important: be sure that the variance of Variable 1 is higher than the variance of
Variable 2. This is the case, 160 > 21.7. If not, swap your data. As a result, Excel
calculates the correct F value, which is the ratio of Variance 1 to Variance 2 (F =
160/21.7 =7.373).

Conclusion: if F > F Critical one-tail, we reject the null hypothesis. This is the case,
7.373 > 6.256. Therefore, we reject the null hypothesis. The variances of the two
populations are unequal.

4- t-Test

This example teaches you how to perform a t-Test in Excel. The t-Test is used to
test the null hypothesis that the means of two populations are equal.

Below you can find the study hours of 6 female students and 5 male students.
HO: ul -pu2 =0

Hl: pl -p2#0
H1Z - e
A B C

1 Female Male

2 26 23
3 23 30
4q 43 18
3 34 25
7] 18 28
7 a2

a8

9

To perform a t-Test, execute the following steps.

1. First, perform an F-Test to determine if the variances of the two populations are
equal. This is not the case.

2. On the Data tab, click Data Analysis.


http://www.excel-easy.com/examples/f-test.html

Data Review View Developer [ e o B ER

% Clea T:I %_‘E S~ 9 Groupr ¥Z [if5Data Analysis
C Reapp S=2 [El:l @ Ungroup - E

7 Textto  Remove ER

W Advanced | Columns Duplicates P~ | Efij Subtotal

EF Drata Tools Outline u Analysis

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak
add-in.

3. Select t-Test: Two-Sample Assuming Unequal Variances and click OK.
[ Data Analysis Lo =)
Analysis Tools

Histogram -

o]

Moving Average Cancel
Random Mumber Generation

Rank and Percentile
Sampling ‘ ‘

t-Test: Paired Two Sample for Means
t-Test: Two-5ample Assuming Equal Variances

Ao

z-Test: Two Sample for Means

4. Click in the Variable 1 Range box and select the range A2:A7.

5. Click in the Variable 2 Range box and select the range B2:B6.

6. Click in the Hypothesized Mean Difference box and type 0 (HO: pl - u2 = 0).
7. Click in the Output Range box and select cell E1.

t-Test: Two-5ample Assuming Unequal Yariances @
Input
Variable 1 Range: SAS2ISAST 55
Variable 2 Range: ERED ERES FRz
Hypothesized Mean Difference: a
[] Labels
Alpha: |0.05
Output options
i@ Dutput Range: S5 ez

(71 Mew Worksheet Ply:
(71 Mew Workbook

8. Click OK.


http://www.excel-easy.com/data-analysis/analysis-toolpak.html
http://www.excel-easy.com/data-analysis/analysis-toolpak.html

Result:

E F G

t-Test: Two-Sample Assuming Unequal Variances

Variable 1  Variable 2
Mean 33 24.8
Variance 160 21.7
Observations 6 5
Hypothesized Mean Difference 0
df 7
t 5tat 1.47260514
P(T<=t) one-tail 0.092170202
t Critical one-tail 1.894578605
P(T<=t) two-tail 0.134340405
t Critical two-tail 2.364624252

Conclusion:

We do a two-tail test (inequality). If t Stat < -t Critical two-tail or t Stat > t Critical

two-tail, we reject the null hypothesis. This is not the case, -2.365 < 1.473 < 2.365.

Therefore, we do not reject the null hypothesis. The observed difference between the

sample means (33 - 24.8) is not convincing enough to say that the average number

of study hours between female and male students differ significantly.



5- Paired Sample t Test

In paired sample hypothesis testing, a sample from the population is chosen and two
measurements for each element in the sample are taken. Each set of measurements
Is considered a sample. Unlike the hypothesis testing studied so far, the two samples
are not independent of one another. Paired samples are also called matched

samples or repeated measures.
Example:

A clinic provides a program to help their clients lose weight and asks a consumer
agency to investigate the effectiveness of the program. The agency takes a sample
of 15 people, weighing each person in the sample before the program begins and 3

months later to produce the table below.

A B C D
1 Two sample t test with paired samples
2
3 Person Before After Difference
4 1 210 197 13
5 2 205 195 10
6 3 193 191 2
7 4 182 174 8
8 5 258 236 23
9 6 239 226 13
10 7 164 157 7
11 8 197 196 1
12 9 222 201 21
13 10 211 196 15
14 11 187 181 6
15 12 175 164 11
16 13 186 181 5
17 14 243 229 14
18 15 246 231 15
19
20 mean 10.933333
21 stddev 6.3298236

Determine whether the program is effective?


https://i0.wp.com/www.real-statistics.com/wp-content/uploads/2012/11/paired-sample-data-excel.jpg

Solution

Let x = the difference in weight 3 months after the program starts. The null

hypothesis is:
HO: u = 0; i.e. any differences in weight is due to chance

We use the Excel’s t-Test: Paired Two Sample for Means data analysis tool or the T

Test. The output from the Excel data analysis tool is shown below:

t-Test: Paired Two Sample for Means

Before | After

Mean 207.9333 197
Variance 215,781 585
Chservations 15 15
Pearson Correlation 0.93372
Hypothesized Mean Difference o
df 14
T50at 6.6897
Pl T==1) one-tail C.14E-06
T Critical one-tail 1.76131
P(T<=t) two-tail 1.03E-05
t Critical two-tail 2.144787

Note that the mean differences are the same, but the standard deviation for the paired
sample case is lower, which results in a higher t-stat and a lower p-value. This is

generally true.

Observation: Since the two sample paired data case is equivalent to the one sample

case.


https://i2.wp.com/www.real-statistics.com/wp-content/uploads/2013/02/image760.png
https://i2.wp.com/www.real-statistics.com/wp-content/uploads/2013/02/image760.png
https://i0.wp.com/www.real-statistics.com/wp-content/uploads/2012/11/paired-samples-excel-tool.png

6- Correlation

The correlation coefficient (a value between -1 and +1) tells you how strongly two
variables are related to each other. We can use the CORREL function or
the Analysis Toolpak add-in in Excel to find the correlation coefficient between two

variables.

- A correlation coefficient of +1 indicates a perfect positive correlation. As variable

X increases, variable Y increases. As variable X decreases, variable Y decreases.

BS ~ J« | =CORREL(A2:A6,B2:B6)

A B C D E F G H I

0 2 15
10 12 10 -

- A correlation coefficient of -1 indicates a perfect negative correlation. As variable

X increases, variable Z decreases. As variable X decreases, variable Z increases.


kholo


BS - fe | =CORREL(A2:A6,B2:B6)

A B C D E F G H I

1 X z
2 0 2 15

3 10 -8 10

4 2 0 - /\ / \

5 12 -10 / N —_—
5 E _4 u ‘l 1 1 T 1

. L 1N2 3N\« 5 z
8 -1

& [l 10

9

10 -15

11

12

- A correlation coefficient near 0 indicates no correlation.

To use the Analysis Toolpak add-in in Excel to quickly generate correlation

coefficients between multiple variables, execute the following steps.

1. On the Data tab, click Data Analysis.

Data Review View Developer [ 6 o Bo E2
K Clea E = |:_?£'|v = Group ~ =z l”EI Data Analysis
f:,-“.e.'-.::. i 4 Ungroup =~ ==

7 ' Textto  Remove . :
S Advanced | Columns Duplicates =27 EESubtntal

EF [rata Tools Qutline ] Analysis

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak
add-in.

2. Select Correlation and click OK.


http://www.excel-easy.com/data-analysis/analysis-toolpak.html
http://www.excel-easy.com/data-analysis/analysis-toolpak.html

Data Analysis
Analysis Tools

Anova: Single Factor
Anova: Two-Factor With Replication

Covariance

Desciptive Statistics
Exponential Smoothing

F-Test Two-Sample for Variances
Fourier Analysis

Histogram

-
Anova: Two-Factor Without Replication A
Correlation -

3. For example, select the range A1:C6 as the Input Range.

4. Check Labels in first row.

5. Select cell A9 as the Output Range.

6. Click OK.

BRX3C v [ fo | A
A | B | <c E F H

1 a B C
2| 0 2 2 15
3| 14 6 11 0 - —_—
4 1 8 3
E— 5 ] _B
5 | 10 5 13 .
6 5 6 4 0 —

7 e 2 3

8

9




P )

Correlation @

Input

== QK
Input Range: SAS1:5CEE R -h.
_ Cancel
Grouped By: @ Columns -
© Rows

Labels in first row

Output options

(@ Qutput Range: A9 Bz
() New Worksheet Ply:

(71 Mew Workbook

Result.

=
e
L]

T

A | 8B | <« D | E F G H I
1A B c
2 0 2 2 15 /\
3 14 6 11 0 A A
R R N "= N,
5 10 5 13
6 5 6 4 0 - . . ¢
7 1 2 3 4 5
8
9 A B c
10 |a 1
11e 0.191516 1
12 |c 0.909268 0.108893 1
13
14

Conclusion: variables A and C are positively correlated (0.91). Variables A and B
are not correlated (0.19). Variables B and C are also not correlated (0.11) . You can

verify these conclusions by looking at the graph.



7-Regression

This example teaches you how to perform a regression analysis in Excel and how to

interpret the Summary Output.

In this study a random sample of service call records for a computer repair operation
were examined and the length of each call (in minutes) and the number of components
repaired or replaced were recorded. The data is given below.

Minutes Units
23
29
49
64
74
87
96
97
109
119
149
145
154
166

=

P P O WwWwoJoyo U d Wi

o O

Below you can find our data. The big question is:

IS there a relation between Minutes (Output) and Units (Input). In other words: can

we predict Minutes if we know the unites?

1. On the Data tab, click Data Analysis.



Data Review View Developer [ a o B ER
& Clea = EE =4+ & Group~ F
2 Reans -

S ¥
7 Textto Remove : o
Wy Advanced | Columns Duplicates P~ | Efi Subtotal

EF Drata Tools Outline P Analysis

= lfgData Analysis

«@ Ungroup =

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak
add-in.

2. Select Regression and click OK.

Dota Anclyss R
Analysis Tools
Histogram - k
Moving Average Cancel
Random MNumber Generation -
Rank and Percentile
I
Sampling
t-Test: Paired Two Sample for Means =
t-Test: Two-Sample Assuming Equal Variances
t-Test: Two-Sample Assuming Unequal Variances
z-Test: Two Sample for Means e

3. Selectthe Y Range (A2:Al5). This is the predictor variable (also called dependent

variable).

4. Select the X Range(B2:B15). These are the explanatory variables (also called

independent variables). These columns must be adjacent to each other.
5. Check Labels.
6. Select an Output Range.

8. Click OK.


http://www.excel-easy.com/data-analysis/analysis-toolpak.html
http://www.excel-easy.com/data-analysis/analysis-toolpak.html

Regression

Input
Input ¥ Range:

Input ¥ Range:

Labels
D Confidence Level;

Cutput options
@ Output Range:
O MNew Worksheet Ply:
O Mew Workbook

Residuals
D Residuals
|:| Standardized Residuals

MNormal Probability
|:| MNormal Probability Plots

n

il
o
=

$A$1:54515]
Cancel
$B$1:$B$15 .5
. Help
[ ] constant is Zero
a5 %
§D5$2 Rz

D Residual Plots
[ Line Fit Plots

Excel produces the following Summary Output (rounded to 3 decimal places).

Minutes Units
23 1
29
49
64
74
87
96
97
109
119
149
145
154
166

W W e~ R R wN

=
o o

Results

SUMMARY QUTPUT

Regression Statistics

Multiple R 0.994
R Square 0.987
Adjusted R 0.986
Standard E 5.392
Observatic  14.000

ANOVA
df SS MS F ignificance F

Regressior 1.000 27419.509 27419.509 943.201 0.000
Residual 12.000 348.848 29.071
Total 13.000 27768.357

Coefficientstandard Errc ~ t Stat P-value Lower 95%Upper 95% ower 95.0%pper 95.0%
Intercept 4.162 3.355 1.240 0.239 -3.148 11.472 -3.148 11.472
Units 15.509 0.505 30.712 0.000 14.409 16.609 14.409 16.609

The regression line is: y = Minutes=4.162+15.509*Units. In other words, for

increasing the units by one, the Time Minutes increases by 15.509, while there is

4.162 minutes does not depend on the unites.

7



Part 3

Some Statistical Charts in Excel

Excel provides fairly extensive capabilities for creating graphs, what Excel
calls charts. You can access Excel’s charting capabilities by selecting Insert >
Charts. We will describe how to create bar and line charts here. Elsewhere on the

website we describe how to create scatter charts. Other types of charts are created in

a similar manner. Once a chart is created three new ribbons are accessible,

namely Design, Layout and Format. These are used to refine the chart created.

1- Bar charts

To create a bar chart, execute the following steps:

1. Enter the data that you are charting into a worksheet.

2. Highlight the data range and select Insert > Charts|Column. A list of bar chart
types is displayed. As usual you can place the mouse pointer over the picture of
any chart type to get a brief description of that chart type. E.g. the first type is a
2-dimensional side-by-side bar chart while second choice is a 2-dimensional
stacked bar chart.

3. Use the Design, Layout and Format ribbons to refine the chart. At any time, you
can click on the chart to get access to these ribbons.

We now demonstrate how to create a bar chart via the following example.


http://www.real-statistics.com/correlation/scatter-diagrams/

Example
The following data represents the sales in millions of Euros in for a certain product
has three brands A, B and C

City Brand A | Brand B | Brand C
London 13.5 12.3 15

Paris 13.8 8.1 5.5
Rome 17.3 4.5 6.9
Madrid 14.8 6.8 2.7
Vienna 7.2 4.2 1.6
Berlin 29.5 21.4 115

The first step is to enter the data into the worksheet. We next highlight the range the

data including the row and column headings, and select Insert > Charts|Column.

Sales
35
30
25
20

15

. Il ll II Il-

London Paris Rome Madrid Vienna Berlin

=]

L

WBrand A mBrand B mBrand C

The resulting chart, although initially the chart does not contain a chart title or axes
titles. To add a chart title click on the chart, select Layout > Labels|Chart Title and
then choose Above Chart and enter the title sales. The title of the horizontal axis can
be added in a similar manner by selecting Layout > Labels|Axis Titles > Primary
Horizontal Axis Title > Title Below Axis and entering the word City. Finally, the



title of the vertical axis is added by selecting Layout > Labels|Axis Titles > Primary
Vertical Axis Title > Rotated Title.

2-Pie charts

For the previous example draw the pie chart for brand A

Brand A

R

v

= London = Paris = Rome Madrid = Vienna = Berlin

Also,

Brand A

\
)

= London = Paris = Rome Madrid m Vienna = Berlin



3-scatter plot

35
30
25
20
15

10

4-Boxplot

35
30
25
20
15
10

Chart Title
®
°® @
®
PR SR
[ ]
2 3 4
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4-Histogram

We explain how to create the Histogram in Excel through the following example
given in the file Histogram.xls. This example teaches you how to create
a histogram in Excel.

1. First, enter the bin numbers (upper levels) in the range C3:C7.

A B C D
1 Number of students
2 22
3 29 20
4 40 25
5 30 30
] 48 35
7 24 40
2 21
9 19
10 24
11 22
12 25
13 52
14 35
15 40
16 31
17 37
18 21
19 23
20
21

2. On the Data tab, click Data Analysis.

Data Review View Developer [ e o B ER
% Clea T:I %_‘E S~ 9 Groupr ¥Z [if5Data Analysis
Gy Reapp =5 Fi 4 Ungroup =~ ==

,\': Textto Remove : o
Wy Advanced | Columns Duplicates P~ | Efi Subtotal

EF Drata Tools Outline u Analysis




Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak
add-in.

3. Select Histogram and click OK.
[ Data Analysis Lo =)

Analysis Tools

0
Correlation -
Covariance Canicel
Descriptive Statistics

Exponential Smoothing
F-Test Two-Sample for Variances

Fourier Analysis
_ P
Mowing Average

Random Mumber Generation
Rank and Percentile e

|
s
=7

Help

=

4. Select the range A2:A109.
5. Click in the Bin Range box and select the range C3:C7.

6. Click the Output Range option button, click in the Output Range box and select
cell F3.

7. Check Chart Output.

[ Histogram @
Input
LnT:nut Range: SASZI8AS19
Bin Range: $0$3:6087
[ Labels
Qutput options
@ Qutput Range: SF53 Az

() Mew Worksheet Ply:
(71 Mew Workbook

[ Pareto (zorted histogram)
|:| Cumulative Percentage

8. Click OK.

)]


http://www.excel-easy.com/data-analysis/analysis-toolpak.html
http://www.excel-easy.com/data-analysis/analysis-toolpak.html

Bin Frequency
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More 2
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Histogram
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)
g
:_ 5
E M Frequency
0]
20 25 30 35 40 More
Bin

9. Click the legend on the right side and press Delete.

10. Properly label your bins.

11. To remove the space between the bars, right click a bar, select Format Data Series
and change the Gap Width to 0%. Select Border Color to add a border.

Result:

F G

Bin Frequency

0-20

21-25
26-30
31-35
36-40

[ SR O R R = < B ]

Frequency

10

Histogram

0-20
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Bin

36-40 40+




Working With Matrices In Excel

To work with matrices in excel, especially with the multiplications and
inverse, you have to follow the following steps

1- Select suitable (m x n) block anywhere else in your spreadsheet to
receive the expected results on them.

2- Press the “F2” key. * Press the “=" sign

3- Type the matrix function with its arguments.

4- Hold down the keys “Ctrl” and “Shift” at the same time and press
the “Enter” key while holding down the other two.

Example:

Find the inverse of

2 -2 1
A=[3 1 -1
1 -3 2



A~ should now appear in the block of cells you had selected (see screen shot on the right below).

. D
o 2 -2| 1
2 3 1 ;l
3 1 3
4 |

=MINVERSE(A1:

If something weird appears (like only one number appearing), you may have pressed the Enter key without
holding down the Ctrl and Shift keys. If this is the case re-select the cells you had chosen for your A~! and
press the Delete key, then repeat the above steps.

2

If A=! does not exist, e.g. the matrix B = ( i3

something that looks like this:

-;)hasnoinvmesincedet(B):O.youmaleeget

5
2.
3




Example
Example:

Find the A.C, such that
2 -2 1 1 1
A=(3 1 —1>, c=(z 1)
1 -3 2 2 3

Solution

1 el |
As an illustration, let A be as given above and C = 2 1 |.Since Aisa3 x 3 matrixand Cisa 3 x2
2: 3

matrix, the product AC is a 3 x 2 matrix. Performing the above steps will give the following screen shots:

SEEEEEEE ¢ | D e F |
1 2 2 1 1 1
2 3 1 -1 2 1
3 1 3 2 3
4
5 [=MMULT(AT.C3.E1F3)
6|
7

ENNEREE C D E | F
¥ 2 i 1 1
2 | 3 1 1 2 1
3 | 1 3 2 3
4
i 0 3
A 3 1
7 -1 4

We are now ready to find the solution to our system of equations.



Solving the system of Equations

Enter the right-hand-side column vector b =

3
7
0

into a 3 x 1 block of cells in your spreadsheet. Also enter

the matrix A into a 3 x 3 block of cells in your spreadsheet.

Since we will get the solution from the matrix product A='b, we first determine the order of the resultant
matrix. In this case, we are multiplying a 3 x 3 matrix by a 3 x 1 vector, we will get a 3 x 1 vector.

Select a 3 x 1 block of empty cells. Type the following: F2 = MMULT(MINVERSE( and select the cells
containing matrix A. Close bracket ). Type a comma and select the cells containing the vector b and close
bracket ). You should have something that looks like this:

A

| 8 |

C

|

D

E

2
3
1

2
1
3

1
-1

:lﬂlmlm'a w‘w}-

[FMMULT(MINVERSE(A1:C3) E1 E3)

~ W

Hold down the Ctrl and Shift keys and press the Enter key while still holding the other two keys. The
values of z,y and z should now appear (see screen shot below).

A

S

D

|

E

o~Nw

Note that we did not have to calculate A=! separately. We simply asked Excel to calculate it for us and then

multiply the inverse by b. Most Excel functions can be nested in this way.



Matrix determinant

Example 1 - 2x2 Matrix

The spreadsheet on the right shows a simple 2x2 matrix. The determinant of this matrix can
be calculated using the Excel Mdeterm function as follows:

=MDETERM( A1:B2)

This gives the result -9.

Example 2 - 3x3 Matrix

The determinant of the simple 3x3 matrix on the right can be calculated using the
following Excel Mdeterm function:

=MDETERM(ALC3)

This gives the result 40.



Generation Random samples

1-

2-

Generation from uniform distribution between 0 and 1
To generate a random sample between 0 and 1 follow the steps below

Highlight number the cells (in column A, for example) equal the sample
size.

Type "=RAND()" without the quotes into the Formula bar, and then press
"Ctrl-Enter" to assign random numbers to your selection.

Random between two numbers

=RANDBETWEEN(a,b)

Random sample

F-Test Two-Sample for Variances
Fourier Analysis

Histogram

Maving Average

Random Mumber Generation
Rank and Percentile

Regressian
_ 2

Data Analysis ? X
Analysis Toaols
Descriptive Statistics ~
Exponential Smoothing Cancel

Help




Sampling

Input
Input Range: SAS1:5A515|

Labels

Sampling Method

O Periodic

Period:

@ Random

Number of Samples: 10

Cutput options
@ output Range: $K$2

O MNew Worksheet Ply:

O Mew Workbook

n
vl

n
il

Cancel

Help

Random number generation from distributions

Random MNumber Generation

Mumber of Variables: 2
Mumber of Random Mumbers: 10
Distribution: Marmal
Parameters

Mean = 0

Standard deviation = 1

Random Seed:

Cutput options

@ Output Range: fKs$2
O MNew Worksheet Ply:

O Mew Workbook

]

vl

Cancel

M Help



e Rank and percentile

Rank and Percentile ? X
- | ok |
— (0].4
Input Range: SAST:5A515] 5.5
Cancel
Grouped By: @ Columns
O Rows Help

Labels in first row

Output options
(@ output Range: 082

i}
vinl

O Mew Warksheet Ply:

O Mew Workbook

X Point x Rank Percent

5 g g 1 100.00%
7 5] 3 2 92.30%
4 2 7 3 84.60%
5 14 5] 4 76.90%
5 1 5 5 53.80%
3 4 5 5 53.80%
2 5 5 5 53.80%
2 3 4 3 30.70%
9 10 4 3 30.70%
4 11 4 3 30.70%
4 13 3 11 23.00%
2 7 2 12 0.00%
3 3 2 12 0.00%
5] 12 2 12 0.00%




